
Practical 8 

 

8.1 Notepad 

 Notepad is a generic text editor included with all versions of Microsoft Windows that 
allows you to open and read plaintext files. If the file contains special formatting or is 
not a plaintext file, it will not be able to be read in Microsoft Notepad. In the image to 
the right, is a small example of what the Microsoft Notepad may look like while running. 

 Users who are using Microsoft Windows can run Microsoft Notepad (notepad.exe) by 
following the steps below. 

Windows 10 
1. On the Windows desktop, find the Windows Search Box. 
2. In the search box, type notepad. 
3. Click on the Notepad option in the search results. 

Windows 8 
1. Go to the Windows Start Screen. 
2. Type notepad and in the search results, click on the Notepad option. 

Windows 7 and earlier 
1. Click Start 
2. In the Run box, type notepad and press Enter. 

or 
1. Click the Start menu. 
2. In the Start menu, click Programs or All Programs, then click the Accessories folder. 
3. Click the Notepad icon. 
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How to create a text file 
 

 To create a text file or .txt file on a computer you need a text editor such as Notepad 

that comes pre-installed with Microsoft Windows. 
 

Open and use Notepad 

 The easiest way to create a text file in Windows is to open up the Notepad software 
program on your computer. The Notepad is a text editor included with Microsoft 
Windows. The Windows Notepad program can be found by following either of the steps 
below. 

 
1. Click Start 
2. In the Run or Search box, type Notepad and press enter. 

Or 
1. Click Start 
2. Open All Programs > Accessories, then click on the Notepad shortcut. 

 

Save the file as a text file 

 You can also create a text file using any other word processing software program, 
like Microsoft Word or WordPad. When saving the file, change the file name or file 
type to Plain Text to save it as a text file. In many of these programs, you'll also have the 
option to save the file as a Rich-Text Format. 
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 After the file has been created and saved, it can also be edited using Notepad or 
another word processing software program. 

 The top of the window is called the title bar: it contains Notepad's "system icon" (top 

left corner), current file name, and system buttons. When a new file is loaded (blank, 

unsaved), as is the case by default, the title bar simply reads "Untitled" until you save 

your file. The word ".txt" may appear at the end of the file name, depending on your 

Windows settings (another file extension can follow the period, depending on which 

document type is opened - see "non-text-files" for more specifics). 

 

 
 

 
 

 The menu bar simply shows available menus' headers: click on any of these words to 
show the corresponding commands; if you hold down the Alt key, Windows will 
underline some letters: press the letter on your keyboard and the menu in question will 
drop down. Each command in the menu is in turn underlined - press the letter 
underlined for the command, and it will behave as though you had clicked on it with 
your mouse - these special keystrokes are called "accelerator keys". These are especially 
useful for commands that don't have a dedicated keyboard shortcut. The "File > Save 
As" command, for example, can be triggered by pressing Alt+F and then the letter "A": 

 

 

 When you launch Notepad, it automatically shows a blank, new document; if you 
already have a text file opened in it, there are two ways to create a new document: 
either launch a new instance of Notepad, or go to the File menu and pick "New" (which 
can also be done by pressing the Ctrl+N hotkey). 

 You can also create a new text file from your Desktop or inside a folder in Windows 
Explorer: right-click on an empty area of the folder / Desktop and choose "New > Text 
Document". Windows will make a new file, called "New Text Document". Type a 
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meaningful name and hit Enter (if the ".txt" extension is visible, leave it intact in the file 
name). Hit Enter once more to open the file in Notepad. 

 You can tell at any point that you have a new document in front of you: the text area is 
blank (until you type something in it), and the title bar will say "Untitled - Notepad", 
like this: 

 
 

 When you start typing in a new document, the text is only "alive" while Notepad is 
running, or while you remain logged on to Windows, and while your computer stays 
on. Close Notepad, log off, or shutdown Windows, and that content is lost forever. 
The first thing to do when you start a new document is to save: click on the File menu 
and choose "Save", or press the equivalent Ctrl+S keyboard shortcut. 

 While it looks different, the Save dialog contains the same options in Windows 7 / 
Vista / XP: if you aren't familiar with Windows' folder structure, keep the default 
location to store your files (the "My Documents" folder). Notepad will "remember" 
where you last opened or saved your documents, and will automatically use that 
location from thereon (until you open from or save to another directory). 

File Encoding 

 

 By default, Notepad will save files using "ANSI text" encoding: if your file contains 
unusual / non-latin characters, you will receive the following error message: "This file 
contains characters in Unicode format which will be lost if you save this file as an ANSI 
encoded file. To keep the Unicode options from the Encoding drop down list. Continue?" 
The bottom line is this: when you create a text file that contains special characters or 
dingbats, just pick UTF-8 from the Encoding dropdown in the Save / Save As dialog. It 
will still be a plain-text file, just "encoded" differently on your hard drive: 

 

 
 
 



Change font family, style, and text size 

 

 Click on the Format menu (Alt+O) and choose "Font": Windows may take a second or 
so, depending on the number of fonts you have installed on your system, and will open 
the Font Dialog: the font family you are currently using is automatically highlighted in 
the Font listing on the left; the font style and size also reflect your current settings. You 
can use the Up and Down arrows on your keyboard to quickly switch between fonts; 
the "Sample" field gives you a real time preview of your pick. 

 

 
 

 Calling it "line wrapping" would be clearer: this feature lets you see long lines inside the 
text area; when word wrap is turned off, you have to scroll horizontally to see the end of 
a long line. Notepad wraps at the word level, finishing every word it starts on the same 
line, unless it is hyphenated; in other words, you won't see the first letters on one line 
and the rest of the word on the next line. To enable or disable word wrap, go to "Format 
> Word Wrap": a checkmark is visible next to the command when the feature is turned 
on, n the status bar will then be hidden, regardless of your settings. 

 
Before word wrap 
 

 
 
After word wrap 
 

 
 
 



8.2 WordPad 
 
WordPad is a text-editing program available in the Microsoft Windows operating system. 
   
Step 1: Open WordPad. The screen should look like this: 
  

 
  
Step 2: You’re now going to choose a font – the design in which the letters you’ll be typing will 
appear. In the third row from the top of the screen, you’ll see a box with a name in it (in this 
example, ‘Calibri’) and a little downward-pointing arrow. The arrow indicates that this is a drop-
down list. When you click on the arrow, it will turn orange and a list will drop down. 
  

 
  



 This particular list consists of all the fonts that you can choose to create your document. 
Scroll down the list and you’ll find even more fonts. Let’s assume that you’d like to use 
the ‘Arial’ font. Click Arial on the list. The name will now appear in the box at the top of 
the screen. 

  

 
  
Step 3: Type ‘Good Morning’ and press the ‘Enter’ key. Have a look at what you’ve done. 
  
Step 4: Choose another font, type ‘Good Morning’ again and press ‘Enter’. Now compare the 
two. Here we’ve chosen ‘Broadway’ as the second font. 
  

 
  
Step 5: You can also change the size of the letters. Next to the font box near the top of the 
screen, you’ll find another box containing a number (’11′ in this example). As you did with the 
font box arrow, click the arrow in this box. A drop-down list appears that consists of numbers. 
These are the numbers of ‘points’ that letters are measured in. By selecting a bigger or smaller 
number, you can choose how big to make your writing. 
  

 Click ’20′ and type ‘Good Morning’ again. 
  

 



  
Step 6: Here’s a shortcut to changing the size of your letters. Next to the number box you’ll see 
two squares, each one containing a letter ‘A’, one bigger than the other (see right). 
 

 
  

 If you click on the button with the bigger ‘A’, the size of your text will get bigger. If you 
click on the other button, it will become smaller. 

  
Step 7: Now experiment with the font tools, which you’ll find under the font box. They are: 
  

 B bold 
 I italic 
 U underline 
 abc strike through 

 subscript 

 superscript 

Plus the highlighting tool and the font color tool, both of which you need to click to cause a 
drop-down list to appear. If you place your cursor over each of the buttons, a description of 
what it does opens. Below you can see what ‘B’ stands for: 

 
  

 Try out each font tool. Below we’ve changed the font back to Arial, size 16, and then 
tried each button in turn. 

  

 
  



Step 8: Now try WordPad’s aligning tools. These push text to one margin or the other (‘align 
left’ and ‘align right’), centre each line (‘centre align’) or make both sides straight. To the right 
of the box containing the font colour tool, you’ll see a row of four similar boxes with lines 
representing text arranged in four different ways: 
  

 
  

 Place your cursor over each one for a description, then try them. Highlight some text by 
clicking on it three times in quick succession. Then click on one of the aligning tools to 
see where the text moves to. 

 These tools are very handy for such jobs as centering a title or placing an address on the 
right. Here’s what happens with ‘Good Morning’ by clicking on each of the first three 
boxes: 

  

 
  
Step 9: To the right of the aligning tools, you’ll find four insert tools. 
  

 
  

 With these, you click to insert a picture from a file, draw a picture to insert in your 
document, automatically insert the date and time or add a particular object. Try 
experimenting with them. 

  
Step 10: You can change the way a word looks after you’ve typed it. Simply double-click on it 
to highlight it – it turns blue to show that it’s been selected. 
  

 
  

 You can now use any of the tools above to change the word – for instance, changing its 
font or size. 

  

 



  

 While it was selected, ‘something’ was changed to a 36 point size and made bold, 
underlined and red! 

  
Step 11: You can also change a paragraph. If you triple-click within one, this will highlight it 
entirely. You can then change its size and colour, make it italic and underline and centre it: 
  

 
  
Step 12: One of the most important things to learn to do with your work in WordPad is 
to save it. That way, you can turn off the computer and later go back to what you’d done. But 
you really should save your work every few minutes. Then, if there’s a power cut, you’ll lose 
only a few minutes’ work. 
  

 To save, go to the top left-hand corner of the WordPad screen and click the arrow in the 
blue box: 

  

 
  

 The ‘File’ drop-down list appears. Now click Save. This saves the document exactly as it 
is. 

  
Step 13: There’s another way of saving your work – by using the ‘Save as’ option. If you use this, 
you can change some of the document’s attributes – its name or its format, for instance. 
  
To use ‘Save as’, place your cursor over Save as. A new menu appears to the right. Move your 
cursor straight to the right on to this and click Rich Text document. (‘Rich Text’ is a format that 
allows you to embed images and other things.) The name of your document will now end with 
‘.rtf’. 
  



 The ‘Documents library’ now appears. This is where your saved document will be kept. 
In the box below the main screen, headed ‘File name’, type in a name for your 
document. Here, ‘First attempt’ is the file name: 

  

 
  

 It’s important that a document’s name relates to its content – for example, ‘letter to 
bank’ – so that you can find it again later. 

 

 Now click Save to keep this document in the Documents library. 
  
Step 19: Finally, as well as saving your document in digital form within your computer, you can 
also print it. Open the ‘File’ drop-down list again and, this time, select Print. Then, moving your 
cursor to the new menu on the right, click Quick print: 
  

 
  

 As long as your printer is set up and turned on, your document will print. 



8.3 Paint 

The Paint Window 

 This is a typical view of the top of the Paint window. 

 

 At the very top is the Title Bar, just as in all programs, below it is a very simple Menu Bar 
and below that is the Ribbon. 

The Title Bar 

 

 At the left end of the Title Bar the first item shows a little paint palette. If clicked, this 
button opens a standard window menu, offering Restore, Move, Size, Minimise, 
Maximise and Close. You are unlikely to want to use this menu, since all of those things 
can be done in quicker ways. 

 The next four items make up the Quick Access Bar, offering buttons 
for Save, Undo, Redo and Customize. 

How to move Quick Access Toolbar to below the Ribbon 

 

 

 If you'd prefer to have Save, Undo and Redo below the ribbon, move your cursor over 
the left end of the title bar until the Customise icon lights up. Click and a menu will 
appear. 

 Near the bottom of the menu that appears, you'll see Show below the Ribbon. 
Click Show below the Ribbon. 



 

 You'll also see other commands that you can add if you wish. I've chosen to add New—
for a new Paint page, Open—to open a previously saved and closed picture, and Print 
Preview. 

 You can click any of these item a second time to undo changes you've made to the Quick 
Access Toolbar. 

Adding Ribbon items to the Quick Access Toolbar 

 

 

 Many other items can be added to the Quick Access Toolbar. On the Ribbon, right click 
on anything you'd like to add to the Quick Access Toolbar and a menu will appear. This 
includes things offered in sub-menus. We’ve added the Pencil tool and Paste 
Transparent. 

 To remove items you've added from the Ribbon, right click the unwanted icon and then 
click the Remove option. 

Other things on the Title Bar 

 

 After the Quick Access items, you'll see the title of your picture followed by the name of 
the program—Paint, of course. If you haven't yet saved your picture, the name will be 
shown as "Untitled". 

 

 At the right-hand end of the Title Bar are the three usual window 
buttons, Minimise, Maximise and Close. If your Paint Window is already maximised—
taking up all of your screen—the middle button will be Restore, which makes the 
window the size you usually have it. 

The Menu Bar 

 

The Menu bar has three items on the left and a Help button at the far right. 



Paint Button 

 

 

 First on the left is the Paint Button, which opens a very comprehensive menu, similar to 
that shown here, plus a list of pictures you've recently saved. Most items are self-
explanatory, but one—Save as— is very important if you ever want to save a cutout 
without losing the rest of your picture. 

 You might like to take a quick look at some of the other items and investigate their uses 
as well. 

Properties dialogue 

 The Properties dialogue, for instance, will give you information about the picture on 
which you're currently working, and let you nominate whether you want to work in 
centimetres, inches or pixels. (So far, I haven't managed to make any of these 
measurements agree in a printed picture, but this may well be due to my lack of 
experience.) 

 There's an option that helps you to set your current picture as your desktop 
background. You can change this as often as you like. 

 
Home Tab 
 

 For nearly everything you do, you'll want the Home tab to be at the front. The Home tab 
contains the Ribbon, from which tools and colors are selected. When you're making use 
of the View tab, you can flick back and forth between Home and View as often as you 
need to. 



View Tab 

 

 Zooming in and out is one of the features that Paint in Windows 7 has improved out of 
sight! Click on the View tab to bring it to the front and you'll find a whole set of useful 
options available. These can be used alone or in conjunction with the Zoom Tool on the 
Ribbon or the slider on the Status Bar. 

 Zoom in and Zoom out tools can be clicked repeatedly to get a closer or more distant 

view. 

 The 100% option is handy when you've finished working in a very zoomed in view. One 
click and you're back to normal. 

 On the Show or Hide part of this tab, you have the option of hiding the status bar. I 
wouldn't advise you to do that. The status bar can be useful. 

 Gridlines are convenient if you want to align shapes accurately. 

 Rulers? If you like. Turn them on and see what you think. 

 On the Display section, you can click for Full Screen View. You can also get a Full Screen 
View by hitting F11. In either case, come back to a normal view by pressing the Esc key. 

 Thumbnail is only available when you are zoomed in. It lets you see how changes you 
make are affecting your picture in normal view. So far, I'm finding that the thumbnail 
cannot always show work on the far right or the bottom of the page. 

The Ribbon 

 All the tools, the color palette, and most commands are grouped together in the ribbon. 
The exceptions are Save, Undo and Redo, which are shown at the left end of the title 
bar, in the Quick Access Toolbar. 

 

 If you choose to use a very small window, the ribbon will appear like this. Drop-down 
arrows below each item will give you access to everything in their menus. 



 If, however, you use a very large window, you will have many more menu items on 
display. 

 

 There is also an option to minimise the ribbon. If you choose this, the ribbon disappears 
entirely, but pops into view if you click on the Home tab. 

The Clipboard Menu 

 

 

 The clipboard menu offers three options—Cut, Copy and Paste. Only when a selection is 
active will the Cut and Copy icons show as being ready. 

 

 Paste is always active, because you may wish to Paste from a picture on your computer. 
Say you've previously drawn and saved a small flower and now wish to add it to your 
present drawing. You'd click the down arrow under Paste, click Paste from and navigate 
to the saved picture, click its name and click Open. 

 You'd be returned to your work space and see the added picture inside a selection 
rectangle, ready for you to drag to its permanent position. 

 

 

 

 



 

Image Menu—Select 

 

 Depending on the size of your window, the Image Menu will look like one of these. 
When you click the down arrow just below the dotted rectangle, or just below the word 
Image, a menu will offer you further choices. 

 Before you can use the buttons on the right of this menu, you select the part of your 
drawing that you want to work with. 

Transparent selection 

 

 At the bottom of the Select menu you'll see Transparent selection. You'll want to use 
this often, so it's a good idea to add it to your Quick Access toolbar. To do this, right click 
on Transparent selection and then click on Add to Quick Access toolbar. On your Quick 
Access Toolbar, there'll be a checkbox in front of the words Transparent selection. 

  While that box has a tick in it, selections will be transparent. 

 To make your selections opaque, just click the checkbox to remove the tick. 

Rectangular selection 

 

 Usually you'll make a rectangular selection. After clicking the rectangular selection tool, 
position the cross-hair cursor at the top left of the part you want to select, press your 
mouse button and drag down to its bottom right. 

 (Actually, you can start at any corner, so long as you finish at the corner diagonally 
opposite.) 



 A dashed rectangle will appear around your selection, with the move 

cursor  replacing the cross-hair one. You can press this cursor down anywhere inside 
your selection and drag to move it, or drag while holding the Ctrl key to make a copy of 
it. 

Freeform selection 

 You may need to make a Freeform selection if the part of your drawing that you want to 
work with is crowded up closely with parts you don't want to include. 

 

 After clicking Freeform selection, drag your mouse around the area you want, as though 
you were drawing a line around it. When you release the mouse button, a selection 
rectangle will appear and it may seem that unwanted parts of the drawing have been 
included, but if you move the selection you'll see that this is not so. 

Copying a selection 

 

 There is, of course, a Copy button on the ribbon, but this way is faster, particularly if you 
want to make multiple copies of a selection. 

 Draw a selection around the part you want to copy, using either the rectangular or the 
freeform selection tool. 

 However your cursor over the selection until the Move Cursor  appears. 

 Hold the Ctrl key as you begin to drag a copy to its new location. Click. If you want to 
continue copying, press the Ctrl key again as you begin to drag the second time. Repeat 
as many times as needed. 

Painting with a selection 

 

 



 Try this. Select a tiny piece from a picture, choosing something with more than one 
color. Hold down the Shift key while you drag it around to make an abstract pattern. 

 You can even try writing with a tiny selection, although you will need to zoom in and use 
the pencil to tidy up blobby bits where you started and finished. 

Selection options 

 To the right of the selection icon you'll see three options, Crop, Resize and Rotate flip. 

Crop 

 The top button, a diamond shape with a line through it, lets you crop your picture so 
that only the selected area remains. This has replaced the old Copy to option and is 
tricky if you want to save cutouts from a drawing. 

 If you click the Save icon after cropping to a selection, your large drawing page will be 
replaced with the cutout. 

How to save a cutout 

1. Save the picture you're working on. 

2. Select the part you want to save as a cutout. 

3. Click the Crop button. 

4. Go to the Paint button and open the menu. 

5. Click Save as 

Be very sure that you do click Save as and not Save. 

6. Type a name for the cutout and click Save. 

You'll be returned to the Paint window with the cutout displayed in it. You'll see that the 

name on the Title bar is the name you used when saving the cutout. 

7. Click the Open icon on your Quick Access Toolbar or from the Paint Button 

menu.  

8. Open the picture with which you wish to continue working. 

 



Resize and Skew 

 

 The second tiny button to the right of the large Select button will open the Resize and 
Skew dialogue. 

. 

 

Resize 

 

 You can quickly resize a selection by dragging any of the little blocks—or handles—on 
the selection rectangle. Just hover your cursor over the handle you want to pull or push 
until a double-ended arrow appears. Press down your mouse button and adjust the 
shape to your liking. 

 However, if you want the size adjustment to be precise, use the Resize dialogue, which 
will appear when you click the Resize icon. Only the top half of this dialogue is 
concerned with resizing. 



 Notice the small square marked Maintain aspect ratio. While this is ticked, whatever 
you type into the Horizontal slot will be repeated beside Vertical and your selection will 
stay exactly in proportion. Only remove the tick if you want the selection to be fatter or 
thinner than it is. 

Skew 

 

 The bottom part of the same dialogue box invites you to skew your selection. When 
using this option, make your selection include a lot of border area to avoid having part 

of the picture chopped off, as has happened here. If this does happen, click Undo  and 
make a wider selection before trying again. 

 

 However, when I tried to skew a heart shape from the Shapes gallery, I had some extra 
color added, apparently from nowhere. How odd! Ah! Now I see. I had red set as Color 

2. I've learned something! Always have your background color—most probably white—
on Color 2 when skewing, moving or whatever.. 

 

 You'll need to experiment with the skew option. Quite small numbers have a marked 
effect. This selection has been skewed 30 degrees both horizontally and vertically. The 
other blue box was skewed 20 degrees horizontally. 

Rotate or flip 

 



 This menu lets you make mirror images of selections, either vertically or horizontally, 
and it also lets you rotate an item 90 degrees. 

 Making a mirror image is handy if you're trying to draw something that looks 
symmetrical. Just copy half of the picture, flip it and join it to itself. See Making a 
Picture the Same on Both Sides. 

Invert Color  

 

 A different set of options is available if you right click on a selection you've made. 

 Items include: Cut, Copy, Paste, Crop, Select all, Invert selection Delete, Rotate and 

Resize, but the one that seems to be available on this menu and nowhere else is Invert 
color, the last item on the menu. This is very important if you want to make a black 
mask with white lettering to create a fancy fill for text. 

The Tools Menu 

 

Pencil 

 The pencil tool can be used for free-hand drawing, or it can be used in a zoomed in 
view for pixel-by-pixel editing. 

 When working with the pencil tool, press with the left mouse button to draw with Color 
1 and with the right mouse button to draw with Color 2. Color 1 in previous versions of 
Paint was referred to as the Foreground color, while Color 2 was the Background color. 
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 In Paint for Windows 7 the pencil's thickness can be changed in the Size tab to 1, 2, 3 or 
4 pixels. 

Fill with Color 

 The Fill with color tool, or the Flood Fill tool if you like, is used to fill an area of a 
single color with a different color. Color 1 will be used if you press the left mouse button 
on the area to be filled. Color 2 will be used if you press with the right mouse button. 

 

 This tool won't work successfully if the part you are trying to color is textured or has 
different shades of one color. It won't work well on areas in a photograph. Even though 
the eye may see just one color, there are bound to be many. 

 Here I've snipped a "plain" brown area from a photo. The second picture shows how a 
small section of it looks when it's magnified. To make the third picture, we had view 
adjust the brightness of the magnified section. The Fill with Color tool can only recolor 
pixels that are exactly the same. 

 The Fill with Color tool always fills with a solid color—unless you are filling shapes that 
you've just made from the Shapes Gallery and have a textured fill chosen there. 

The Text Tool 

 The Text tool in Paint for Windows 7 is a great improvement on earlier versions. 

 

 The one exception to this is that Paint 7 always anti-aliases text, so the idea of stacking 
red text on top of black to get a shadowed effect seems to be a thing of the past—
unless you turn off Smooth screen fonts in the Performance section of Advanced 
System Settings. 

 You can, if you like, just go ahead and insert your text as you always have, but I'd 
recommend that you open a new document and play with this tool. 



 To begin inserting text, click on the text tool. Your cursor changes to an insertion bar. 

 With this cursor, drag to draw an oblong that you think will be about right to hold your 
text. 

 Now, until you've completed these steps, don't click anywhere outside that oblong. 

 The Text Toolbar appears. 

 Type your text. 

 Now drag the cursor over the text so that it becomes highlighted. 

 Click the down arrow at the end of the Font Name box, so that a list of fonts drops 
down. 

 Run your cursor—without pressing any mouse buttons—up and down the font list. As 
you do this, the appearance of the text you've typed will change appropriately. 

 When you like what you see, click on the name of that font. The font list will close. 

 You can repeat this process with the Font Size list. 

 You can also click the Background from Transparent to Opaque or vice versa, and 
change both Color 1 and Color 2. You can even run your cursor, while the Color 2 button 
is operative, over the palette, and see how different backgrounds look behind your text. 

 You can hover your cursor over any of the handles—little blocks—on the bounding box 
of the text, press your mouse button and resize the box you've drawn, and if you hit the 
enter key from the end of your text the box will expand downwards. You can also use 
the handles to move the text box across the page, pulling it wider on one side and 
pulling it in on the other. 

 Although there is no way to centre your text automatically, you can put your cursor to 
the left of the text and hit the space bar as many times as necessary to centre it. 
 

 

 And that's not all. You can type more text, in a different color and a different font and 
size, right in the same text box! When you are making changes, only highlighted text will 
be affected. 

 Use the slider on the status bar to change zoom levels, though. Clicking on the Magnifier 
pastes the text. 

 Only when you are completely satisfied should you click anywhere on the page outside 
of your text box. When you click away from the text box, the Text Toolbar disappears 
and the text becomes part of your picture. It can no longer be edited in any way. 

The Eraser 

 With the left button depressed, the eraser tool changes whatever it is dragged 
across to the background color—Color 2. 



 With the right button depressed, the eraser tool changes pixels of Color 1 to Color 2, but 
leaves everything else unaffected. You can use this to quickly and easily change an area 
of, say, red to one of, say, blue. 

 

 I pressed the left mouse button while I dragged the Eraser across the first picture. Color 
2, the background color, was white. 

 For the second picture, I set Color 1 to blue and Color 2 to white. 

 I pressed my right mouse button while I dragged across the picture. 

 For the third picture, I set Color 2 to pink and Color 1 to lime green. I pressed my right 
mouse button while I dragged across the picture. 

 There's no color tolerance in Paint; only pixels of exactly the same color are affected, so 
it's pretty useless on textured color. 

The Color Picker 

 The Color Picker Tool is used to sample and match any color in your picture. 

 It's especially useful when colors in the picture are different from those on the palette. 

 Say you're zoomed in, working with the Pencil tool on an area that has many shades of 
blue, and you want to use one of those shades. Click the Color Picker and click directly 
on the shade of blue that you want to use. The tool will immediately change back to the 
Pencil, loaded with the color you want. 

The Magnifier 

 The Magnifier Tool can be clicked over an area of which you want a closer view. Left 
clicks give a closer view. Right clicks zoom out. So much less clunky than in previous 
versions of Paint! 

Brushes 

 Brushes let you paint in various widths and textures. 

 Widths are controlled by the brushes and the Size Tool together, textures by the 
brushes. 



 Please remember that anything you plan to recolor needs to have plain, solid color to 
begin with. All but two of the brushes use different shades of the base color to produce 
a textured effect. 

 

 Here I've drawn a line with each of the offered brushes, using the same color and the 
same line width for each. I've labelled each line according to its tooltip in the gallery. 

 On the right I've dragged the color eraser from top to bottom through all the different 
brush lines. You can see that only two lines, those labelled "Brush" and "Airbrush", are 
able to be fully erased; that is, each of the others uses more than one shade of green. 

 It can be helpful to consider the brushes as three separate items: the normal Paintbrush, 
the Spray Can or Airbrush, and the rest as Special Effects Brushes. The normal 
Paintbrush is the default, so that helps. 

 

 We found the calligraphy brushes interesting. I was able to write a letter fairly 
convincingly with Calligrahy Brush 1. I was a dead loss with Calligraphy Brush 2. 

 Once you have chosen a brush, you only need to click the main brush picture to use that 
same brush again. 

Shapes 

 



 A bit confusingly for users of previous versions of Paint, the Line Tool and the Curved 
Line Tool have been cunningly concealed in the Shapes Gallery, along with Rectangles, 
Rounded Rectangles Ellipses and Freehand Polygons. As well, though, there are a 
number of added shapes: arrows, speech balloons, various stars and others. 

Basics for All Shapes 

 

 Open the Shapes Gallery by clicking the down arrow under the Shapes picture and click 
the shape you want to draw. You have to have chosen a shape before you try to use the 

Outline or Fill buttons and before you choose a line thickness. 

 

 Please be aware that if you choose Solid Fill when your background color is set to white, 
the shape will be filled with white until it is pasted, and ditto with Solid Outline drawn 
with the right button. That is, if you move the shape onto a colored area while its 
bounding box is still active, the white fill will show. 

 However, if the shape is pasted onto a white area and later selected and moved onto a 
colored part of the picture, the white part will then be transparent. 

 Having chosen a shape, click the Outline button to the right of the Shapes picture and 
click on Solid Color or a texture of your choice. 

 Click the Fill button and click on No Fill, Solid Color or a texture of your choice. 

 Click the down arrow below the Size picture and click on a line thickness. 

 Press a mouse button and drag to draw the shape. 

 If you draw with your left mouse button, Color 1 will be used for the Outline. 

 If you draw with your right mouse button, Color 1 will be used for the Fill. 

 Once you've drawn a shape, but while the bounding box is still visible, you can change 
Color 1 and Color 2, you can change the line width, alter choices in the Outline and Fill 



lists, drag handles to change the size and proportions of the drawn shape or move it to a 

different place in your picture. 

 When you are fully satisfied, click well away from your newly drawn shape to cancel the 
bounding box and paste the shape into your picture. 

. 

Straight Lines 

 

 Straight lines are the first offering in the Shapes Gallery. 

 Open the gallery and click the Line button. Click the Outline button and click on Solid 
Color or a texture of your choice. 

 Click the Size drop-down and click a line thickness, then select colors. Lines drawn while 
the left mouse button is pressed will use Color 1, those drawn with the right button will 
use Color 2. 

 Draw your line. It will be perfectly straight. 

 If you hold down the Shift key while drawing a line, it will be precisely horizontal, 
precisely vertical, or precisely at 45 degrees. 

Curved Lines 

 

 The Curved Lines tool isn't quite as easy to use as it once was. Closed curves don't come 
with just three clicks, and if you're familiar with my eight petalled flower from earlier 
versions, that doesn't work in Paint for Windows 7! I've written fresh directions, but on 
a separate page. Flower Bunch for Paint in Windows 7 

 Meanwhile, here are the basics of drawing curved lines. 

 Click the little arrow under the Shapes picture and click the  Curved Line button. 

 Click the Outline button and choose Solid Color or a texture of your choice. Then click 
under the Size picture and choose a line thickness. Choose colors if you wish. 

 Draw a line. 
 

http://fay.iniminimo.com/flowers_for_7.html


 

 For a pointed curve, like this one, put your cursor somewhere near the finishing end of 
the line. With the mouse button pressed, move the cursor around slowly and watch the 
line following it. When you think the line is where you want it, release the mouse 
button. 

 Now put your cursor somewhere close to the beginning of the line, press the mouse 
button and again move the cursor slowly around until you like what you see, then 
release the mouse button. 

 

 To make a smooth curve, after you have drawn your line, put your cursor close to the 
beginning of the line. 

 With the mouse button pressed, move your cursor around slowly until you feel the 
curve is almost as you want it and release the mouse button. 

 Now press your mouse button down near the end where you finished the line. Move the 
cursor around until you are happy with the curve, then release the mouse button. 

Closed Curves 

 

 To draw a closed curve, first draw a triangle—to be erased later. Make the triangle short 
and fat or tall and skinny, depending on the finished shape you want. Be sure to use a 
color other than the color you'll use for your finished shape, so that you can erase it 
easily. 

 Having chosen the Curved Line tool, and set line thickness and color, put your cursor 

where you want the point of the shape. 

 



 Press your mouse button and move the cursor the tiniest bit, just enough to convince 
the program that you've drawn a very short line. Release the mouse button and click 
once on each of the other points of the triangle. 

Repeated Curves 

 When you're drawing several curved lines one after the other, you'll find it helpful to 

click the selection tool or the pencil when each curve is completed. When you do this it 

cancells the bounding box around the completed curve. Then go back to the Shapes tool 

and choose the curved line again. 

Elipses, Rectangles, Circles and Squares 

 If you want to draw an exact shape—say a square or a circle—hold the Shift key while 
you draw and release the mouse button before you let go of the Shift key. 

Freehand Polygons 

 

 To draw a freehand polygon, click the Polygon button  in the gallery. After setting 
Line, Fill and so on, hold a mouse button down and draw the first line of the polygon. 
Then release your mouse button and click where you want the next line to end. Keep 
clicking end points until you want the last line to finish the shape, then double click. 

Line Thickness, The Size Tool 

 

 This tool becomes active only after you have chosen either a Brush or a Shape, so 
choose your Brush or Shape and you'll then find you can click the down arrow under 
Size and choose a line thickness. 

 The line thicknesses offered vary according to the brush you've chosen. 



Colors 

 The Color section of the ribbon has three parts: Boxes showing the active colors—Color 
1 and Color2, the Color Palette and the Edit Colors button. 

The Color Boxes 

 

 Color 1 is the Foreground Color, and is always black when you open Paint or open a 
different Paint page. 

 Color 2 is the Background Color, and is always white when you open Paint or open a 
different Paint page. 

 To change a color, make sure that its Color box is in focus, as shown by the yellowy 
background. If it is not, simply click it and then, in the Palette, click on the color that you 
want. 

 When you have an active shape or some active text on your page, hovering your cursor 
over a color in the Color Palette will make the shape or text take on that color 
temporarily. You can click to apply the change if you like it. 

The Color Palette 

 

 The two top lines of the Color Palette show all the colors available whenever you are 
making a picture. 

 The line of blank squares at the bottom will show any colors you have edited during this 
session. Once Paint is closed, those colors will vanish away. 

Edit Colors 

 

 The Edit Colors button takes you into the Edit Colors dialogue. There you can click any 
color on an extended palette and click the Add to Custom Colors button. 

 You can also, if you wish, alter the depth of the chosen color by clicking any point on a 
sliding "dark to light" scale on the right of the dialogue, before you click the Add to 
Custom Colors button. 



 When you click O.K. in this box, only one color will be added to the squares under the 
palette. To add further colors, you must return to the dialogue and add them one at a 
time. 

 The Custom Colors are kept only during one session. If you particularly want certain 
colours to use the next time you open Paint, make little swatches of them on an actual 
picture. You might like to then crop to the swatches, do a Save as—calling the cutout 
"Custom Colors", so that you can Paste from the saved swatches on a later occasion. 

The Status Bar 

 

 

 The Status Bar sits at the very bottom of the Paint Window, where it offers information 
and can be used to help as you work. We'll look at it's features from left to right. 

Cursor Position 

 

 Gives your Cursor Position, which is helpful when you want to position something 
precisely. 

Selection Size 

 

 Shows the size of a selection you're making, or of an object you're drawing. 

Image Size 

 

 Shows the size of your entire picture, even if it is very large and so not all visible in the 
window. If you haven't changed the units in the Properties dialogue this measurement 
will be in pixels, but you do have the option of changing to inches or centimetres. 

Disk Size 

 

 Once you've saved a picture, this will show its Size on Disk. In a very small window, this 
figure may not be shown. 

Zoom Slider 

 



 The Zoom Slider is convenient if you're working in a zoomed-in view and want to zoom 
out. However, you can't zoom in on a particular spot, as you can with the Magnifier. 

Saving Your Work 

 It's a good idea to save your picture as soon as you begin, then click the Save button on 
the Quick Access Toolbar every few minutes. This saves loss of work if the program 
closes unexpectedly, as in a power failure. If in the end you don't much want to keep the 
picture, you can always delete it. 

 When you hit Save for the first time, you'll find yourself in a dialogue box where you're 
invited to type a name for the picture. Do so, and accept the default format, which is 
png—unless, of course, you have a particular reason for choosing some other format. 
Having typed a name, click the Save button and you'll be returned to your picture. 

 After that, when you click the Save button your work won't be interrupted. 

Saving a Copy—Save as 

 Sometimes you may have made a really good picture, want to add something to it but 
worry that you might spoil it. The thing to do then is Save a Copy. 

 

 Go to the Paint button and open the menu. 

 

 Click Save as 

 In the dialogue box, the existing name of the picture will be suggested. Just change it a 
little by adding, say, a "2" or the word "Copy", then click the Save button. 

 You will be returned to the Paint window with the copy ready for you to work on. Now 
you can make changes with confidence, knowing that if things do go wrong your original 
picture is safe and unchanged. 

 
 
 
 
 
 
 
 
 
 



8.4 The Windows Taskbar 
 

 The taskbar is the thin strip that runs across the bottom of your screen. It is split into a 
number of different areas: a round Start button, Quick Launch icons, a notification area, 
and a clock. All other areas are the Taskbar itself. The image below shows where the 
different areas are: 

 

 The Start button is explained in a section all of its own, as it's probably the most 
important area of the Taskbar. Click here to go the Start button page: 

The Windows 7 Start button 

 There is one more area on the Taskbar, and it's easily overlooked - the Show Desktop 
button. In the images above, you can just see a narrow rectangle to the right of the 
clock: 

 

 Click this button to minimize all open programmes and reveal the desktop. 

  

Quick Launch Icons 

 In the main image above, take a look at the three big icons to the right of the round 
Start button. These are quick launch icons, meaning you can quickly launch any of the 
programmes you see there. When you hold your mouse over one of the icons, you'll see 
a small popup rectangle that shows you a preview of any open windows. In the image 
below, we're holding our mouse over the Firefox icon. (Firefox is a web browser used to 
display internet pages. It's Internet Explorer's main competitor.) 

http://www.homeandlearn.co.uk/BC/win7/windows7_start_button.html


 

 Click on the preview window and it opens the programme up in full screen. 

 There are several ways to add new programmes to the Quick Launch area, but Windows 
7 makes it a lot easier. Open up a programme using the Start menu. When it's open, use 
the right mouse button to click its icon in the Taskbar. A new menu appears: 

 

 In the image above, we have Microsoft Excel open. Right-clicking its icon in the Taskbar 
gave us the above menu. Once "Pin this program to the taskbar" is clicked with the left 
mouse button, it will appear permanently in the Quick Launch arrear. If you want to get 
rid of any Quick Launch programmes, the item on the menu will say "Unpin this program 
from the taskbar" when you right-click. 

 You can also use the Start menu to add programmes to the Quick Launch area. Again, 
right-click the programme you want to add. From the menu, select "Pin to Taskbar". In 
the image below, we're adding Notepad as a Quick Launch icon: 

 



 The result is a new icon in the Quick Launch area: 

 

Notification Area 

 The Notification area, formally called the System Tray, is the area of the Taskbar where 
you can view programmes and tasks that are running in the background, as well as view 
important messages about updating your computer. (Although the clock is considered 
part of the Notification area, we'll look at this separately.) 

 In the image below, the Notification area shows three icons: 

 

 The first one, the white arrow, is for hidden icons. Click the white arrow to see which 
icons have been hidden: 

 

 Probably the only one of the four icons above that you'll have is the speaker icon. This 
sets the volume for your speakers. If yours is too low, click the speaker icon to see a 
slider that you can move up and down: 

 



 The second of the three icons in the Notification area is a white flag. This flag alerts you 
to issues that need to be taken care of. Click the flag icon to see if there are any 
problems: 

 

 As you can see, Windows 7 is telling us that there is 1 message, and that it's to do with 
Windows Defender. You can click on the "1 message" heading at the top, or on the 
message itself. You can also open the "Action Center" from here. 

 The third icon that appears in the Notification area (on our computer, anyway) is a 
Network icon. This tells us that we have an internet connection, and there are no 
problems. If the internet access is down, there will be a red X through this icon: 

 

 The red X will disappear when the problem with the internet is solved. 

 In the next part, we'll take a look at the Windows 7 clock, and the date and time. 

The Date and Time in Windows 7 

 The default clock shows you the date as well as the time: 

 

 You can change how Windows 7 displays these. You can even add clocks for other time 
zones. 

 Click on the clock to see a new popup window: 

 



 As you can see, as well as a clock you get a calendar. Click the arrows to display new 
months: 

 

 To change the settings for the clock, the date, and the time, click on "Change date and 
time settings". You should see the following dialogue box appear: 

 

 If your clock is showing the wrong time, or the wrong date, click the button "Change 
date and time ..." When you do, you'll see the following dialogue box appear: 

 



 To change the date, click the black left and right arrows to move to the correct month. 
Then select the date you want. To change the time, click the up and down arrows below 
the clock. Click OK when the date and time are correct. 

 If you want to play around with the way Windows 7 displays the Date and Time, click on 
"Change calendar settings" then play around with the settings. You may need to restart 
before the changes take effect. 

 If you want more than one time zone to appear, click the" Additional Clocks" tab at the 
top of the Date and Time dialogue box: 

 

 Click the box to the left of "Show this clock" and the drop down list will become 
available. Select a time zone from the list. Type a name for you clock in the box below 
the heading "Enter display name". Then click OK. Click OK again to get rid of the Date 
and Time dialogue box. Now click the clock area again in the bottom right of the taskbar. 
You should see your new clock appear: 

 



8.5 Adjusting display resolution 
 

 You can adjust the screen resolution in Windows 7 to control how sharp and detailed 
the images, words, and icons on your screen appear. At higher resolutions, things are 
crystal clear, but they’re also much smaller; at lower resolutions, things are larger and 
easier to see, but there are fewer items visible at any one time. 

 This is really a personal decision; there is no right or wrong setting. However, if you plan 
to spend much time in front of a computer: adjusting the screen resolution to what feels 
comfortable to you pays off in increased productivity as well as decreased eyestrain. 

 Choose Start→Control Panel→Appearance and Personalization and click the Adjust 
Screen Resolution link. 

 Adjusting the screen resolution will adjust the resolution for every user account. 

 In the resulting Screen Resolution window, click the arrow to the right of the Resolution 
field. 

 
 
The Screen Resolution dialog box. 
 

 Use the slider to select a higher or lower resolution. 

 Sliding the resolution down will make the items on your screen larger, but also a bit 
fuzzier. 

 You can also change the orientation of your display by making a choice in the 
Orientation drop-down list. The Advanced Settings link in the Screen Resolution dialog 
box displays another dialog box where you can work with color management and 
monitor settings. 

 Click Apply. 

 Windows will show you your desktop at the new resolution and ask if you prefer the 
new setting. 

 Click OK to accept the new screen resolution or Cancel to go back to the old setting. 

 If you don’t click OK within a couple of minutes, the previous setting will be restored 
automatically. 



8.6 Using web Browsers 
 

 A web browser is a type of software that allows you to find and view websites on the 
Internet. Even if you didn't know it, you're using a web browser right now to read this 
page! There are many different web browsers, but some of the most common ones 
include Google Chrome, Internet Explorer, Safari, and Mozilla Firefox. 

 No matter which web browser you use, you'll want to learn the basics of browsing the 
Web. In this lesson, we'll talk about navigating to different websites, using tabbed 
browsing, creating bookmarks, and more. 

 We'll be using the Google Chrome web browser throughout this lesson, but you can use 
any browser you want. Keep in mind that your browser may look and act a bit 
differently, but all web browsers work in basically the same way.  

URLs and the address bar 

Each website has a unique address, called a URL (short for Uniform Resource Locator). It's like a 
street address that tells your browser where to go on the Internet. When you type a URL into 
the browser's address bar and press Enter on your keyboard, the browser will load the page 
associated with that URL. 

In the example below, we've typed www.bbc.com/travel into the address bar. 
 

 

Links 

 Whenever you see a word or phrase on a website that's blue or underlined in blue, it's 
probably a hyperlink, or link for short. You might already know how links work, even if 
you've never thought about them much before. For example, try clicking the link below. 

 Links are used to navigate the Web. When you click a link, it will usually take you to a 
different webpage. You may also notice that your cursor changes into a hand icon 
whenever you hover over a link. 

 

http://www.bbc.com/travel


 If you see this icon, it means you've found a link. You'll find other types of links this way 
too. For example, many websites actually use images as links, so you can just click the 
image to navigate to another page. 

Navigation buttons 

 The Back and Forward buttons allow you to move through websites you've recently 
viewed. You can also click and hold either button to see your recent history. 

 

 The Refresh button will reload the current page. If a website stops working, try using 
the Refresh button. 

 

Tabbed browsing 

 Many browsers allow you to open links in a new tab. You can open as many links as you 
want, and they'll stay in the same browser window instead of cluttering your screen 
with multiple windows. 

 To open a link in a new tab, right-click the link and select Open link in new tab (the 
exact wording may vary from browser to browser). 

 



 To close a tab, click the X. 

 

 To create a new blank tab, click the button to the right of any open tabs. 

 

 

Bookmarks and history 

 If you find a website you want to view later, it can be hard to memorize the exact web 
address. Bookmarks, also known as favorites, are a great way to save and organize 
specific websites so you can revisit them again and again. Simply locate and select 
the Star icon to bookmark the current website. 

 

 Your browser will also keep a history of every site you visit. This is another good way to 
find a site you visited previously. To view your history, open your browser settings—
usually by clicking the icon in the upper-right corner—and select History. 

 



Downloading files 

 Links don't always go to another website. In some cases, they point to a file that can 
be downloaded, or saved, to your computer. 

 If you click a link to a file, it may download automatically, but sometimes it just opens 
within your browser instead of downloading. To prevent it from opening in the 
browser, you can right-click the link and select Save link as (different browsers may use 
slightly different wording, like Save target as). 
 

 

Saving images 

 Sometimes you may want to save an image from a website to your computer. To do 
this, right-click the image and select Save image as (or Save picture as). 

 



Plug-ins 

 Plug-ins are small applications that allow you to view certain types of content within 
your web browser. For example, Adobe Flash and Microsoft Silverlight are often used 
to play videos, while Adobe Reader is used to view PDF files. 

 If you don't have the correct plug-in for a website, your browser will usually provide a 
link to download it. There may also be times when you need to update your plug-ins. 
Review our lesson on Installing and Updating Plug-ins to learn more. 

 

 

 

 

 

 

 

 

 

 

http://www.gcflearnfree.org/internet-tips/installing-and-updating-browser-plugins/1/


8.7 Configuring Simple Networking 

 The Network and Sharing Center in Windows 7, 8 and 10 is one of the more important 
and useful Control Panel apps that lets you see information about your network and lets 
you make changes that can affect how you access resources on the network. 

 Unfortunately, most people never mess around with network settings because they 
don’t understand what everything means and are afraid to mess something up. 
However, once you understand the settings, you can fix problems on your own, increase 
your privacy, and quickly setup file and printer sharing between multiple computers. 

Opening Network & Sharing Center 

 The first step is to open the Network and Sharing Center. The quickest way to get to it is 
by clicking on Start and typing in network and. This will instantly bring up the app in the 
list. 

 

 In all versions of Windows, the app is located in the Control Panel. In Windows 7, just 
click on Start and the Control Panel is listed on the right side of the Start Menu. In 
Windows 8.1 and Windows 10, just right-click on the Start Menu and choose Control 
Panel from the list. 

 



 In the Control Panel, you can click on the Network and Internet category and then click 
on Network and Sharing Center. If you are in icon view, just click directly on Network 
and Sharing Center. 

 

Private or Public Network 

 The first thing you’ll see when you open the Network and Sharing Center is your current 
connection to the network and to the Internet. Windows 7 has a little bit more 
information and also a couple of more options. 

 

 In Windows 8 and Windows 10, they cleaned up the interface by getting rid of a couple 
of items and combining other items. 



 

 At the top, you’ll see the active network or networks, the network type, the type of 
access, HomeGroup info and the connection info. The first thing to understand about 
this info is the network type, which is listed directly below the name of the network. 

 In the above examples, one has Home network listed and the other has Private 
networklisted. This is very important because when you are connected to a private or 
home network, there are a lot of sharing settings that are set by default to be trusting. 
This means others can find your computer on the network, possibly access shared 
folders, stream media from your computer, etc. 

 Windows will normally try to figure this out for you automatically so that when you 
connect to a public WiFi network, it will use the Public profile and not the private one. 
Sometimes, Windows will ask you if you want to enable sharing or find devices once you 
connect to a network and if you say yes, it will make the network private. If you choose 
no, it will make the network public. 

 You can also manually change the network type to Public or Private depending on what 
kind of privacy you want. This can be useful, for example, if you are visiting someone 
and you want to make sure no one can access any data on your computer while you are 
connected to their network. Change the network type to Public and no one will be able 
to discover your computer on the network. 

 To the right of the network name and network type, you’ll 
see HomeGroup and Connections. Next to HomeGroup, you’ll see a link that 
says Available to join or Ready to create depending on whether a HomeGroup already 
exists on the network or not. A HomeGroup allows you to easily share files, printers and 
more between computers. I talk more about it in the Advanced Sharing Settings section 
below. 

 Next to Connections, you can click on the name of the WiFi or Ethernet network to bring 
up the status info dialog for the current connection. Here you can see how long you 
have been connected, the signal quality for WiFi networks, the network speed, etc. You 
can also disable the connection and diagnose the connection if there is a problem. 



 

 For WiFi networks, this screen is useful because you can click on Wireless 
Properties and then click on the Security tab and view the WiFi password. This is really 
useful if you have forgotten the WiFi password, but still have a computer that is 
connected to the network. 

 

 Lastly, if you click on Details, you can get more info about the current network like the 
Default Gateway (router IP address), MAC address, and computer IP address. 

http://www.online-tech-tips.com/computer-tips/find-wireless-access-point-ip-address/
http://www.online-tech-tips.com/computer-tips/how-to-determine-or-find-your-mac-address/
http://11986-presscdn-0-77.pagely.netdna-cdn.com/wp-content/uploads/2009/11/network-status.png
http://11986-presscdn-0-77.pagely.netdna-cdn.com/wp-content/uploads/2009/11/network-password.png


 

Advanced Sharing Settings 

 The advanced sharing settings dialog is main place for managing how your computer 
communicates with the rest of the network. In Windows 7, you have two profiles: Home 
or Work and Public. Only one profile can be active at a time. All the settings are the 
same and repeated under each profile. 

 

 In Windows 8 and 10, you have three profiles: Private, Guest or Public and All 
Networks. Basically, it’s the same settings as in Windows 7, but just split up more 
logically. Let’s go through the various settings: 

 

http://11986-presscdn-0-77.pagely.netdna-cdn.com/wp-content/uploads/2009/11/network-details.png


 Network Discovery – This setting is turned on for private networks by default and it 
means that your computer can be seen by other computers and vice versa. What this 
means in practice is that when you open Windows Explorer, you might see the name of 
another computer connected to your network under Network Locations. 

 

 File and Printer Sharing – This setting will allow others to access shared folders and 
printers on your computer. I always turn this to Off even on private networks unless I 
need to use it in a specific situation. There are so many times when guests come over to 
my house, connect to the network and then could possibly browse my system. Only 
shared folders can be viewed, but you’d be surprised how folders can become shared 
without your knowledge. 

 HomeGroup connections – If you really do need to share files and folders, you should 
just setup a HomeGroup, which is more secure and a lot easier to configure. If you do 
run into trouble, just read my HomeGroup troubleshooting guide. 

 Now expand out All Networks if you are using Windows 8 or Windows 10. There are a 
couple of more settings here. 

http://helpdeskgeek.com/windows-7/setup-windows-7-homegroup/
http://helpdeskgeek.com/windows-7/windows-7-cannot-connect-to-homegroup/


 

 Public Folder Sharing – I recommend turning this off unless you specifically need to 
share data with another computer. The reason is that it’s very easy to accidentally save 
files into these publicly shared folders without realizing it, which will then be accessible 
by anyone on the network. A very useful feature when you need it, but a big privacy risk 
otherwise. 

 Media Streaming – This is another option you should keep disabled until you need to 
use it. This basically turns your computer into a DLNA server so that you can stream 
music, movies and pictures to other devices on the network like an Xbox One, etc. When 
enabled, it opens up quite a few ports in your firewall also. 

 File Sharing Connections – This should always be set to Use 128-bit encryption unless 
you need to share files with Windows 95, Windows 98 or Windows 2000 computers. 

 Password Protected Sharing – I highly recommend turning on password protected 
sharing because it will force users to enter a username and password for an account on 
your computer in order to access any data. 

Setup New Network & Troubleshoot Problems 

 The next part I want to talk about is the section under Change your networking 
settings. In Windows 10, you can either setup a new connection or troubleshoot 
problems. 



 

 For setting up a new connection, you only have four options in Windows 8/10: Connect 
to the Internet, Setup a new network, manually connect to a WiFi network or 
connection to a VPN. Note that creating an ad-hoc network is no longer possible in 
Windows 10. 

 If you click on Troubleshoot problems, you’ll get a list of troubleshooting links for the 
Internet, network adapter, HomeGroup, Shared Folder, Printers, etc. 

 

 These are not just troubleshooting guides, they are actual programs that run and fix 
issues with various networking related services. I have found the Internet 
Connections andNetwork Adapter troubleshooting fixes to be the most useful. 

http://www.online-tech-tips.com/computer-tips/how-to-connect-two-computers-or-laptops-wirelessly/
http://11986-presscdn-0-77.pagely.netdna-cdn.com/wp-content/uploads/2009/11/setup-new-connection.png
http://11986-presscdn-0-77.pagely.netdna-cdn.com/wp-content/uploads/2009/11/troubleshoot-network-problems.png


Change Adapter Settings 

 Lastly, let’s talk about the Change adapter settings link on the left-hand side. You 
probably won’t use this too often, but it does come in handy when troubleshooting 
network problems. 

 

 Here you will see a list of all the network adapters on your computer. If you have an 
Ethernet port and WiFi card, you’ll see both items listed. You might also see other 
network adapters, but they are usually always virtual, meaning they are created by a 
software application like a VPN client or virtual machine program. 

 If you’re having connection problems, you can simply right-click on the adapter and 
choose Diagnose. This will usually fix any problem with a misconfigured network 
adapter. If you right-click and choose Properties, you can configure your computer to 
use a static IP address rather than obtaining one from a DHCP server. 

 

http://www.online-tech-tips.com/windows-8/windows-8-assign-static-ip-address/
http://www.online-tech-tips.com/windows-8/windows-8-assign-static-ip-address/


8.8 Creating users and Shares 

About User Accounts 

Windows 8 supports two types of user accounts that users can use to log on to the computer. 

The two types of user accounts that Windows 8 supports are: 

 Microsoft Account – Microsoft account is an account that can be created either on 

Hotmail.com or live.com. Since the accounts on these sites can be accessed from anywhere 

in the world, users can use the same account credentials to log on to any Windows 8 

computer that is connected to the Internet. 

 Local Account – Unlike Microsoft account, a local user account is authenticated from the 

local Security Account Manager (SAM) file that is located in the system drive of the 

computer. Since every Windows 8 computer has a different local SAM file, local accounts 

created on one Windows 8 computer can log on to that computer only. 

Different Ways of Creating Local Accounts 

Microsoft Windows 8 allows administrators to create local user accounts in 2 different ways 

which are: 

 From ‘PC settings’ Window – Windows 8 has a new window named ‘PC settings’ that allows 

administrators to customize, and sometimes manage a Windows 8 computer. When 

Windows 8 is installed in a home computer, many users use ‘PC settings’ window to create a 

new local user account because of its simple wizard. 

 From Computer Management Snap-in – Computer Management snap-in can be initiated by 

right-clicking the Computer icon that is available in the left pane in Libraries window. In 

production environments, most administrators prefer creating local user accounts from the 

Computer Management snap-in because it allows them to add the newly created users to 

one or more groups using easy wizards. 

Irrespective of the process, administrative privileges are always required to create a local user 

account on a Windows 8 computer. 

Creating a Local User Account Using ‘PC settings’ Window 

To create a local user account on a Windows 8 computer using ‘PC settings’ window, 

administrators must follow the steps below: 

1. Use administrator account credentials to log on to Windows 8 computer. 
2. From the Start screen, click Desktop tile to view the desktop. 
3. From the desktop screen, hover mouse to the bottom right corner of the window. 
4. From the displayed options in the right, click Settings. 
5. From the bottom of Settings pane, click Change PC settings. 



 

Click Change PC Settings 

6. On PC settings window, click to select Users from the left pane. 
7. From the right pane, under Other users section, click Add a user. 

 

Add a User 

8. From the bottom of Add a user window, click Sign in without a Microsoft account. 
9. On next window, click Local account to create a local user account. Alternatively Microsoft 

account can also be clicked to create a Microsoft account. 

http://www.tutorialspoint.com/articles/wp-content/uploads/2013/01/Click-Change-PC-Settings2.jpg
http://www.tutorialspoint.com/articles/wp-content/uploads/2013/01/Add-a-User.jpg


 

Click Local Account 

10. On next window, populate User name, Password, Reenter password, and Password 
hint fields with the desired values. 

 

Specify Desired Values 

11. Click Next to continue. 
12. On next window, click Finish to complete the local user account creation process. 

 

http://www.tutorialspoint.com/articles/wp-content/uploads/2013/01/Local-Account.jpg
http://www.tutorialspoint.com/articles/wp-content/uploads/2013/01/Specify-Desired-Values.jpg


Creating a Local User Account from Computer Management Snap-in 

To create a local user account on a Windows 8 computer using Computer Management snap-

in, administrators must follow the steps below: 

 Use administrator account credentials to log on to Windows 8 computer. 

 From the Start screen, click Desktop tile to view the desktop. 

 On the desktop screen, press Windows + R keys simultaneously to initiate Run command 

box. 

 In the available field in the Run command box, type COMPMGMT.MSC command and 

hit Enter key. 

 On Computer Management snap-in, under System Tools category from the left pane, 

double-click to expand Local Users and Groups. 

 From the expanded list, right-click Users. 

 From the context menu that appears, click New User. 

 On New User box, populate User name, Full name, and Description, Password, and Confirm 

password fields with the desired values. 

 

 

Create User from Computer Management Snap-in 

1. Click Create to create a new local user account. 
2. When done, close Computer Management snap-in. 

2 methods to create a shared folder on Windows 8: 

Method 1: Create a shared folder by directly sharing it with specified users. 

Step 1: Right-click the folder to be shared with other people, choose Share with on the context 
menu and select Specific people. 

http://www.tutorialspoint.com/articles/wp-content/uploads/2013/01/Create-User-from-Computer-Management-Snap-in.jpg


 

Step 2: In the window of File Sharing, tap the down arrow, choose a user from the drop-down 
list and click Share. 

 

Step 3: Choose whether to turn on network discovery and file sharing for all public networks. 

In the pop-up window named Network discovery and file sharing, you can choose Yes, turn on 
network discovery and file sharing for all public networks, or No, make the network that I am 
connected to a private network. 



 

After these three steps, the selected folder is successfully shared in the computer. 

 

Method 2: Share a folder in its sharing setting. 

Step 1: Right-click a folder and choose Properties in the context menu. 

 



Step 2: In the folder's properties window, open Sharing and click Advanced Sharing to 
continue. 

 

Step 3: Choose Share this folder and tap Permissions. 

 



Step 4: Click Add button to go to select users whom you would like to share the folder with. 

 

Step 5: As the Select Users or Groups dialog box turns up, input user name in the empty box 
and tap OK. 

 

Tip: For this step, you can also click Advanced button, select Find Now in the pop-up window, 
choose a user from the list and click OK. 



 

Step 6: Set folder permissions for the user selected and click OK. 

 

 

http://www.isunshare.com/windows-8/set-folder-permissions-in-windows-8-8.1-computer.html

